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1 Flash Fill - your new best friend! 

Suppose you had a spreadsheet like this: 

 

However, all you want is the product IDs at the start, the letters. Is there an easy way to 
extract just the letters? Yes - use Flash Fill. (Excel versions 2013 and above.) 

Create a simple spreadsheet like the one in the image above. Now click inside cell B2. 
Enter the first of the letters, ABC: 

 

Press the enter key on your keyboard and you'll see cell B3 selected: 
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To do a Flash Fill, hold down the CTRL key on your keyboard. Keep the CTRL key held 
down and press the letter E on your keyboard. Excel Flash Fills the rest of the product 
IDs for you: 

 

Notice the small box that's appeared in the bottom right of the selected cell (B3). Click the 
arrow on the box to see a menu: 

 

Click the item that says Accept suggestions. 
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If you want, you can extract the numbers to the C column. Click inside cell C2. Enter the 
first set of numbers, which are 123. Press the enter key on your keyboard to move down 
to cell C3. Now press CTRL + E again to have Excel perform a Flash Fill. You should see 
the rest of the numbers appear in cells C3 to C5: 

 

Notice that Flash Fill has even added a column heading of ID in cell C1. It's guessed this 
because the heading in cell A1 (Product ID) also has a space between it. Flash Fill is 
grabbing all the characters after the space. 

Example Two - extract First Names and Last Names from a cell 

Suppose you have a series of names in the A column, and that the first and last names 
are all typed in the same cell: 

 

What you want to do, however, is to have the first names in the A column and the last 
names in the B column. Is there an easy way to do this? Yes - use Flash Fill! 

Create a simple spreadsheet like the one in the image above. Click inside cell B2. Enter 
the first name of Ken. Press the enter key on your keyboard. This will select cell B3. 
Perform a Flash Fill by holding the CTRL key and pressing the letter E. Excel will finish 
adding the first names to cells B3 to B7: 
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Now click inside cell C2. Enter the last name Carney. Flash Fill the rest of the last names 
down to cell C7: 

 

Notice that Flash Fill has added the heading Names to cell C1. You can delete this, if you 
like. (Just click inside cell C1 then hit the delete key on your keyboard.) 
 
We can now delete the entire A column, because we don't need the full names. Highlight 
the entire A column by clicking on the letter A column heading: 
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From the Cells panel on the Home ribbon at the top of Excel, click the Delete item, From 
the menu, select Delete Sheet Columns: 

 

When you click on Delete Sheet Columns you'll find that the old A column disappears. 
The B and C columns shift to the left, and you're left with new A and B Columns: 

 

Add some new headings and you're done: 
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Example Three - append text 

You can use Flash Fill to append some text to values in a cell. Suppose you had a list of 
pictures in the A column of a spreadsheet: 

 

However, none of these picture names have a file ending. Suppose you wanted to add 
.jpeg to the end of your picture names. Is there an easy way to do that? Yes - use Flash 
Fill! 

Create the simple spreadsheet above. Click inside cell B2 and enter pic1.jpeg. Press the 
enter key to move the selection down to cell B3. Now press CTRL + E. Excel will Flash 
Fill the rest of the file names: 
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Flash Fill can save you a whole load of time, and is well worth getting to grips with. 
Especially if you're doing text formatting on cell contents. 

 

2 Data Tables in Excel 2007 to 2016 

In Excel, a Data Table is a way to see different results by altering an input cell in your 
formula. As an example, we're going to alter the interest rate, and see how much a Rs. 
10,000 loan would cost each month. The interest rate will be our input cell. By asking 
Excel to alter this input, we can quickly see the different monthly payments. Want to know 
how much we'd pay back each month if the interest was 24 percent per year. But other 
banks may be offering better deals. So we'll ask Excel to calculate how much we'd pay 
each month if the interest rate was 22 percent a year, 20 percent a year, and 18 percent 
a year. 

The formula we need is the Payment one you met in a previous section - PMT(). Here it 
is again: 

PMT(rate, nper, pv, fv, type) 
We only need the first three arguments. So for us, it's just this: 

PMT(rate, nper, pv) 
Rate means the interest rate. The second argument, nper, is how many months you've 
got to pay the loan back. The third argument, pv, is how much you want to borrow. 

Let's make a start then. On a new spreadsheet, set up the following labels: 

 

So we'll put our starting interest rate in cell B3 (rate), our loan length in cell B4 (nper), 
and our loan amount in cell B5 (pv). 

Enter the following in cells B3 to B5: 
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So you need to enter 24.00% in cell B3, 60 in cell B4, and Rs. 10,000 in cell B5. 

We'll enter our formula now. Click inside cell D2 and enter the following: 

=PMT(B3 / 12, B4, -B5) 
Cell B3 is the interest rate. But this is for the entire year. In the formula, we're diving 
whatever is in cell B3 by 12. This will get us a monthly interest rate. B4 in the formula is 
the number of months, which is 60 for us. B5 has a minus sign before it. It's a minus figure 
because it's a debt. 

When you press the enter key on your keyboard, Excel should give you an answer of Rs. 
287.68. 

Now that we have our function in place, we can create an Excel Data Table. First, though, 
we need to tell Excel about those other interest rates. It will use these to work out the new 
monthly payments. Remember, Excel is recalculating the PMT function. So, it needs 
some new values to calculate with. 

So enter some new values in cells C3, C4, and C5. Enter the same ones as in the image 
below: 

 

We have put the PMT function in cell D2 for a reason. This is one Row up, and one 
Column to the right of our first new interest rate of 22%. The new monthly payments are 
going to go in cells D3 to D5. Excel needs the table setting out this way. 
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So that Excel can work out the new totals, you have to highlight both the new values and 
the Function you're using. 

So highlight the cells C2 to D5. Your spreadsheet should look like this: 

 

As you can see, the cells C2 to D5 are now highlighted. This includes our new interest 
rate values in the C column, and our PMT function in cell D2. We can now create an Excel 
Data Table. This will work out new monthly payments for us. So, do this: 

• From the Excel menu bar, click on Data 
• Locate the Data Tools panel 
• Click on the "What if Analysis" item: 

 

In Excel 2016, the What If Analysis is on the Forecast panel, to the right of Data Tools: 

 

When you click on the "What if Analysis" item, you'll see the following menu: 
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Click on Data Table, and you'll see this small dialogue box: 

 

In the dialogue box, there is only a Row input cell or a Column input cell. We want 
Excel to fill downwards, down a column. So we need the second text box on the dialogue 
box "Column input cell". If we were filling across in rows, we would use the "Row input 
cell" text box. 

The Input Cell for us is the one that contains our original interest rate. This is the cell you 
want Excel to substitute. 

So click inside the Column input cell box and enter B3: 

 

Click OK. When you do, Excel will work out the new monthly payments: 

 

So if we could get an 18 percent interest rate, our monthly payments would be Rs. 253.93. 

If you click inside any of the cells D3 to D5, then look at the formula bar, you will see this: 
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{=TABLE(,B3)} 
That's Excel's way of telling you that a Table has been created, based on the input cell 
B3 

 

3 Data Table [Contd.] 

We'll do one more Data Table, just so that you get the hang of things. This time, we'll use 
a simpler formula than PMT, and we'll use Rows instead of Columns. This is the scenario: 

You have 250 items that you want to sell on EBay. Your unique selling 
point is this - All items are only Rs. 5 each! Except, you feel Rs. 5 may be 
a bit expensive for the goods you're selling! What you want to know is how 
much profit you'll make if you reduce your prices to Rs. 4.50, how much if 
you reduce to Rs. 4.00, and how much for a reduction to Rs. 3.50. Assume 
that everything gets sold. 

To start creating your Table, construct a spreadsheet like the one below. Make sure that 
you start on a new sheet. 

 

In cell B1 is the number of items we want to sell (250). Cell B2 has the original price (Rs. 
5.00). And the Reductions Row has our new values. Cell B3 has a 0 because there's no 
reduction for Rs. 5.00. Row 4 is where our Profits will go. 
The formula to work out the profits is simply the Number of Items multiplied by the Price 
Per Item. So, click inside cell B4 and enter the following formula: 

= B1 * B2 
Your spreadsheet will then look like this: 
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So if we manage to sell all our items at Rs. 5, we'll make Rs. 1,250. We're a bit dubious, 
though. Realistically, all our items won't sell at this price! Let's use an Excel Data Table 
to work out how much profit we'd make at the other prices. 

Again, we put the answer in cell B4 for a reason. This is because when you want Excel 
to calculate a Data Table in Rows, the formula must be inserted one Column to the Left 
of your first new value, and then one Row down. Our first new value is going in cell C3. 
So one column to the left takes us to the B column. One row down is Row 4. So the 
formula goes in cell B4. 

Next, click inside cell B3 and highlight to cell E4. Your spreadsheet should now look like 
this one: 

 

Excel is going to use our formula in cell B4. It will then look at the new values on Row 3 
(not counting the zero), and then insert the new totals for us. To create a Data Table then, 
do the following: 

• From the Excel menu bar, click on Data 
• Locate the Data Tools panel (Forecast panel in Excel 2016) 
• Click on the "What if Analysis" item 
• Select Data Table from the menu 

 

Just like last time, you'll get the Data Table dialogue box. The one we want now, though, 
is Row Input Cell. But what is the Input Cell this time? 

Ask yourself what you are trying to work out, and what you want Excel to recalculate. You 
want to work out the new prices. The formula you entered was: 

= B1 * B2 
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Excel is going to be changing this formula. You only need to decide if you want Excel to 
alter the B1 or the B2. B1 contains the number of items; B2 contains the price of each 
item. Since we're trying to work out the profits we'd get if we change the price, we need 
Excel to change B2. So, enter B2 for the Row Input Cell: 

 

When you click OK, Excel will work out the new profits: 

 

So setting a price of Rs. 3.50 per item, you'd make Rs. 875 profit. You'd make Rs. 1,000 
at Rs. 4.00 per item, and Rs. 1,125 if you sell for Rs. 4.50. 

Hopefully, Data Tables weren't too difficult! But they are a useful tool when you want to 
analyses values that can change. In the next section, we'll look at scenarios. 

 

4 Excel Scenarios 

Scenarios come under the heading of "What-If Analysis" in Excel. They are like tables in 
that you are changing values to get new results. For example, What if I reduce the amount 
I'm spending on food? How much will I have left then? Scenarios can be saved, so that 
you can apply them with a quick click of the mouse. 

An example of a scenario you might want to create is a family budget. You can then make 
changes to individual amounts, like food, clothes, or fuel, and see how these changes 
effect your overall budget. 

We'll see how they work now, as we tackle a family budget. So, create the spreadsheet 
below: 
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The figure in B12 above is just a SUM function, and is your total debts (=SUM (B3:B10). 
The figure in D3 is how much you must spend each month (not a lot!). The figure in D13 
is how much you have left after you deduct all your debts. In cell D13, then, enter =D3 - 
B12 

With only 46 pounds spending money left each month, clearly some changes have to be 
made. We'll create a scenario to see what effect the various budgets cuts have. 

• From the top of Excel click the Data menu 
• On the Data menu, locate the Data Tools panel (Forecast panel in Excel 2016) 
• Click on the What if Analysis item, and select Scenario Manager from the menu: 

 

When you click Scenario Manager, you should the following dialogue box: 
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We want to create a new scenario. So click the Add button. You'll then get another 
dialogue box popping up: 

 

The J22 in the image is just whatever cell you had selected when you brought up the 
dialogue boxes. We'll change this. First, type a Name for your Scenario in the Scenario 
Name box. Call it Original Budget. 
Excel now needs you to enter which cells in your spreadsheet will be changing. In this 
first scenario, nothing will be changing (because it's our original). But we still need to 
specify which cells will be changing. Let's try to reduce the Food bill, the Clothes Bill, and 
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the Phone bill. These are in cells B7 to B9 in our spreadsheet. So, in the Changing 
Cells box, enter B7:B9 
Don't forget to include the colon in the middle! But your Add Scenario box should look like 
this: 

 

Click OK and Excel will ask you for some values: 

 

We don't want any values to change in this first scenario, so just click OK. You will be 
taken back to the Scenario Manager box. It should now look like this: 
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Now that we have one scenario set up, we can add a second one. This is where we'll 
enter some new values - our savings. 

Click the Add button again. You'll get the Add Scenario dialogue box back up. Type a new 
Name, something like Budget Two. The Changing Cells area should already say B7:B9. 
So just click OK. 
You will be taken to the Scenario Values dialogue box again. This time, we do want to 
change the values. Enter the same ones as in the image below: 

 

These are the new values for our Budget. Click OK and you'll be taken back to the 
Scenario Manager. This time, you'll have two scenarios to view: 
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As you can see, we have our Original Budget, and Budget Two. With Budget Two 
selected, click the Show button at the bottom. The values in your spreadsheet will 
change, and the new budget will be calculated. The image below shows what it looks like 
in the spreadsheet: 

 

Click on the Original Budget to highlight it. Then click the Show button. The first values 
will be displayed! 
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Click the Close button on the dialogue box when you're done. 
So, a Scenario offers you different ways to view a set of figures, and allows you to switch 
between them quite easily. 

How to Create a Report from a Scenario 

Another thing you can do with a scenario is create a report. To create a report from your 
scenarios, do the following: 

• Click on Data from the Excel menu bar 
• Locate the Data Tools panel (Forecast panel in Excel 2016) 
• On the Data Tools panel, click What if Analysis 
• From the What if Analysis menu, click Scenario Manager 
• From the Scenario Manager dialogue box, click the Summary button to see the 

following dialogue box: 

 

What you're doing here is selecting cells to go in your report. To change the cells, click 
on your spreadsheet. Click individual cells by holding down the CTRL key on your 
keyboard, and clicking a cell with your left mouse button. Select the cells D3, B12 and 
D13. If you want to get rid of a highlighted cell, just click inside it again with the CTRL key 
held down. Click OK when you've selected the cells. Excel will then create your Scenario 
Summary: 
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All right, it's not terribly easy to read, but it looks enough. Perhaps it will be enough to 
convince our family to change their ways. Unlikely, but a nice diagram never hurts! 

 

5 Goal Seek 

Goal Seek is used to get a particular result when you're not too sure of the starting value. 
For example, if the answer is 56, and the first number is 8, what is the second number? 
Is it 8 multiplied by 7, or 8 multiplied by 6? You can use Goal Seek to find out. We'll try 
that example to get you started, and then have a go at a more practical example. 

Create the following Excel spreadsheet 

 

In the spreadsheet above, we know that we want to multiply the number in B1 by the 
number in B2. The number in cell B2 is the one we're not too sure of. The answer is going 
in cell B3. Our answer is wrong at the moment, because we have a Goal of 56. To use 
Goal Seek to get the answer, try the following: 

• From the Excel menu bar, click on Data 
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• Locate the Data Tools panel and the What if Analysis item. (In Excel 2016, the What 
If item is on the Forecast panel, next to Data Tools.) From the What if Analysis 
menu, select Goal Seek 

• The following dialogue box appears: 

 

The first thing Excel is looking for is "Set cell". This is not very well named. It means 
"Which cell contains the Formula that you want Excel to use". For us, this is cell B3. We 
have the following formula in B3: 

= B1 * B2 
So enter B3 into the "Set cell" box, if it's not already in there. 

The "To value" box means "What answer are you looking for"? For us, this is 56. So just 
type 56 into the "To value" box 

The "By Changing Cell" is the part you're not sure of. Excel will be changing this part. For 
us, it was cell B2. We're weren't sure which number, when multiplied by 8, gave the 
answer 56. So type B2 into the box. 

You Goal Seek dialogue box should look like ours below: 

 

Click OK and Excel will tell you if it has found a solution: 
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Click OK again, because Excel has found the answer. Your new spreadsheet will look 
like this one: 

 

As you can see, Excel has changed cell B2 and replace the 6 with a 7 - the correct answer. 

We'll now try a more practical example. 

Goal Seek Number Two 

Consider this problem: 

Your business has a modest profit of 25,000. You've set yourself a new 
profit Goal of 35,000. At the moment, you're selling 1000 items at 25 each. 
Assume that you'll still sell 1000 items. The question is, to hit your new 
profit of 35,000, by how much do you have to raise your prices? 

Create the spreadsheet below, and we'll find a solution with Goal Seek. 
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The spreadsheet is split into two: Current Sales, and Future Sales. We'll be changing the 
Future Sales with Goal Seek. But for now, enter the same values for both sections. The 
formula to enter for B4 is this: 

= B2 * B3 
And the formula to enter for E4 is this: 

= E2 * E3 
The current Price Per Item is 25.00. We want to change this with Goal Seek, because our 
prices will be going up to hit our new profits of 35,000. So try this: 

• From the Excel menu bar, click on Data 
• Locate the Data Tools panel and the What if Analysis item. From the What if Analysis 

menu, select Goal Seek 
• The following dialogue box appears: 

 

For "Set cell", enter E4. This is where the formula is. The "To Value" is what we want our 
new profits to be. So enter 35000. The "By changing cell" is the part we're not sure of. 
For us, this was the price each item needs to be increased by. This was coming from cell 
E3 on our spreadsheet. So enter E3 in the "By changing cell" box. Your Goal Seek 
dialogue box should now look like this: 

 

Click OK to see if Excel can find an answer: 
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Excel is now telling that it has indeed found a solution. Click OK to see the new version 
of the spreadsheet: 

 

Our new Price Per Item is 35. Excel has also changed the Profits cell to 35 000. 

Exercise 
You've had a meeting with your staff, and it has been decide that a price change from 25 
to 35 is not a good idea. A better idea is to sell more items. You still want a profit of 35 
000. Use Goal Seek to find out how many items you'll have to sell to meet your new profit 
figure. 
In the next part, well take a closer look at cell references in Excel. 

 

6 Absolute Cell References 

A significant difference in Excel spreadsheets is between absolute cell references and 
relative cell references. To see what this is all about, we'll create a simple spreadsheet. 
This will illustrate relative cell references, which is what we've been using so far. 

So open up Excel and enter the same values as in the image below: 
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In cell B2, you need the following formula: 

= A1 + A2 
What do you think would happen if we copied anD pasted the formula from B2 to cell B3? 
Let's see: 

• Click inside cell B2 to highlight it 
• Click on cell B2 with your right mouse button, and select Copy from the menu 

that appears 
• Now click into cell B3 
• Again, right click the cell to get the menu. But this time click Paste 
• Your spreadsheet should now look like ours: 

 

Cell now says 25! We were trying to work out what 20 + 25 was, and have the wrong 
answer. So why did Excel put 25 into cell B3 and not 45? 

With cell B3 still highlighted, look at the formula bar at the top of Excel. You should see 
this formula: 

= A2 + A3 
Click into B2, however, and the formula is this: 

= A1 + A2 
The problem is due to cell referencing. When you clicked Copy from the menu, Excel 
didn't only copy the formula. It took at look at where the cells were in the formula, relative 
to the B2 cell, and copied this as well. From B2, the first cell reference (A1) is up one row, 
and left 1 column (the red arrow below): 
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The second cell reference (A2) is one column to the left of cell B2: 

 

When you clicked into cell B3 and selected Paste from the menu, Excel was not only 
pasting the formula, it was pasting this "up 1, left 1". Take a look at the two images below. 
We're now starting at cell B3. Have a look at where the two red arrows are pointing now. 

The first cell reference: 

 

The second cell reference: 

 

So, the first red arrow is pointing to cell A2, and the second red arrow is point to cell A3. 
This is what was copied. Excel then took the formula to mean this: 

= A2 + A3 
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But it should have been this: 

= A1 + A2 
If you want the correct answer in cell B3, you have to stop Excel from using this Relative 
Cell Referencing that it's currently doing. What you need is Absolute Cell Referencing. 

Absolute cell referencing involves nothing more than placing a dollar symbol ($ ) before 
each letter and number. 

Click inside of cell B2 on your spreadsheet, and change the formula to this: 

= $A$1 + $A$2 
Now copy and paste it over to cell B3 again. You should have the correct answer, this 
time: 

 

 
Excel will use Absolute Formula in its own calculation, so it's worth getting used to them. 
But to recap: 

• If you need to copy and paste formulas, use Absolute cell references 
• Absolute referencing means typing a dollar symbol before the numbers and 

letters of each cell reference (You can mix absolute and relative cell 
references, though). 

 

7 Named Ranges in Excel 2007 to 2016 

A Named Range is way to describe your formulas. So you don't have to have this in a 
cell: 

= SUM(B2:B4) 
You can replace the cell references between the round brackets. You replace them with 
a descriptive name, all your own. So, you could have this, instead: 

= SUM(Monthly_Totals) 
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Behind the Monthly_Totals, though, Excel is hiding the cell references. We'll see how it 
works, now. 

Open up Excel and create the spreadsheet below: 

 

The formula is in cell B5, and just adds up the monthly totals in the B column. 

Define a Name 

Setting up a Named Range is a two-step process. You first Define the Name, and then 
you Apply it. To Define your name, do this (make sure you have the formula in cell B5): 

• Highlight the cells B2 to B4 (NOT B5), then click the Formulas menu 
• Locate the Named Cells panel in Excel 2007. In Excel 2010, 2013 and 2016, locate 

the Defined Names panel instead. 
• Click Name a Range in Excel 2007 and Define Name in Excel 2010 and 2013 

 

 

From the Name a Range menu, click Name a Range (Define Name again in Excel 
2010/16): 
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You'll then get the following dialogue box: 

 

Click OK on the New Name dialogue box. Notice that the Name is our heading 
of Monthly_Totals. 
When you click OK, you'll be returned to your spreadsheet. You won't see anything 
changed. But what you have done is to Define a Name. You can now Apply it. 

Apply a Name 

To apply your new Name, click into cell B5 where your formula is, and do this: 

• On the Named Cells panel, Click Name a Range. For Excel 2010 to 2016 users 
click Define Name 

• From the menu, select Apply Names 
• From the Apply Names dialogue box, select the Name you want and click OK: 
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When you click OK, Excel should remove all those cell references between the round 
brackets, and replace them with the Name you defined: 

 

In the image above, cell B5 now says: 

=SUM(Monthly_Totals) 
The cell references have been hidden. But Excel still knows about them - it's you that 
can't see them! 

Exercise Study the spreadsheet below, now that we have added another Named Range 
to cell C5: 
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Using the same techniques just outlined, create the same Named Range as in our image 
above. Again, the formula we've used is just a SUM formula: 

= SUM(C2:C4) 
You need to start with this, before you Define the Name and Apply it. 

Using Named Ranges in Formulas 

We'll now use two Named Ranges to deduct the tax from our monthly totals. 

So, to define two new Names, do the following: 

1. Click inside cell B5 to highlight it 
2. From the Formulas menu bar, locate the Named Cells panel, and click Name a 

Range > Name a Range (Excel 2007). In Excel 2010 to 2016, click Define Name > 
Define Name from the Defined Names panel. 

3. From the New Name dialogue box, click in to the Name textbox at the top and 
enter Monthly_Result (with the underscore character) 

4. Click OK 
5. Click inside cell C5 and do the same as step 2 above. This time, however, 

enter Tax_Result as the Name 

You should now have two new Names defined. We'll now Apply these new names. First, 
add a new label to your spreadsheet: 
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Click in to cell B7, next to your new label, and enter the following formula: 

= B5 - C5 
With the formula in place, we can Apply the two new Names we've just defined: 

• From the Formulas menu bar, locate the Named Cells panel, and click Name a 
Range > Apply Names (Excel 2007). In Excel 2010 to 2016, click Define Name > 
Apply Names from the Defined Names panel. 

• The Apply Names dialogue box appears 
• Click Monthly_Result to select it 
• Click on Tax_Result to select it: 

 

• Click the OK button 
• Excel will replace your cell references with the two Names you Defined 
• Your spreadsheet should look like ours: 

 

If you look at the formula bar, you'll see the two Named Ranges. The formula is easier to 
read like this. But it's not terribly easy to set up! They can be quite useful, though. 
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In the next part, we'll take a look at how to set up your own custom names that you can 
use in formulas. 

 

8 Create a Custom Name in Excel 

You can set up a custom name to be used as a constant. An example of a constant is PI 
when working with circles. If you need to use PI in formulas you don't need to type out 
3.1415 all the time, you can just do this: 

= PI() * 5 
We'll use the spreadsheet below to set up our own custom name: 

 

We'd like to work out a discount, depending on the shoe type. So Slingback shoes might 
have a discount of 5 percent but Stacked Heels might have a discount of 12 percent. To 
set up a custom name, click on the Formulas ribbon at the top of Excel. On the Defined 
Names panel, select Define Name > Define Name: (In Excel 2010 and 2013, locate 
the Defined Names panel instead.) 

 

You should see the New Name dialogue box appear: 
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In the Name area at the top, type slingback_discount. In the Refers to textbox at the 
bottom, you can type a cell reference or a formula. Type =5% in the textbox, though. Then 
click OK when your dialogue box looks like this: 

 

To use your new custom name, click into cell D2 to select it. Then click into the formula 
bar at the top. Type = C2 *. Then start typing your custom name. As soon as you type the 
"sl" you'll see a popup box appear: 

 

The popup box should have your custom name on the list. Double click it and Excel will 
add it to your formula. Because we typed =5% in the Refers totextbox of the New Name 
dialogue box the constant slingback_discount will always be 5%. 
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Press Enter when the formula is complete and you should see the discount appear in cell 
D2: 

 

If you want to delete a custom name, click the Name Manager on the Defined 
Names panel: 

 

You'll see the following dialogue box appear: 
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If you want to edit your custom name, click the Edit button at the top. To delete a name, 
simply select the name from the list then click the Delete button. 

In the next part, you'll see how to set up a Name to associate text with numbers. 

 

9 More on Named Ranges (Named Range - associate a text value with a number) 

You can set up a named range where a text value is associated with a number value. For 
example, suppose you had four sales people in your team: John, Ali, Priyanka, and Helen. 
Each person sold many units per year. John sold 21 units, Ali sold 31 units, Priyanka sold 
32 units, and Helen sold 45 units. You want to know how many units Ali and Helen sold 
combined. If you use Named Ranges, you could set up a formula with this in a cell on 
your spreadsheet: 

=Ali + Helen 

You can see this in the image below, where cell A7 is highlighted: 

 

In the formula bar, it doesn't say =B3 + B5. It says =Ali + Helen. Yet we still get an answer 
of 76, just the same as if we'd entered the formula =B3 + B5. The name Ali has been 
associated with a value of 31, and the name Helen has been associated with a value of 
45. So how does it work? 
Create the simple spreadsheet above, with the same headings and values. Now select 
the cells from A2 to B5: 
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With the cells selected, click on the Formulas ribbon at the top of Excel. On the Formulas 
ribbon, locate the Defined Names panel, and click on Create from Selection: 

 

When you click on Create from Selection, you'll see the following dialogue box appear: 

 

Make sure Left Column is selected, as this is where the text names are. Now click OK. 
You will be returned to Excel, where it will look as though nothing has happened. 
However, click in cell A7 and type =Ali. You should Excel already knows about this name: 
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With Ali selected in the small box at the top, you can press the tab key on your keyboard 
to have Excel finish the entry. Our simply double click the name. (We have the Name 
Alice set up elsewhere in our spreadsheet.) 

Now complete the formula by typing + Helen: 

 

Select Helen from the list and press the enter key on your keyboard. You should see this 
on your spreadsheet: 

 

What we've done here is to create names, and had Excel associate values with them. 
This can greatly improve the readability of your spreadsheets. 

Delete a Named Range 

If you want to delete or edit a name, click the Name Manager item from the from the 
Defined Names panel on the Formulas ribbon. You should see a dialogue box appear 
(this may only be in Excel from versions 2016 onwards): 
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Here, we want to delete the Alice name we set up, so have highlighted that item. Click 
the Delete button at the top to get rid of the highlighted name. 

In the next section, we'll explore Pivot tables in Excel. 

10 Excel Pivot Tables 

A Pivot Table is way to present information in a report format. The idea is that you can 
click drop down lists and change the data that is being displayed. For example, choose 
just one student from a drop-down list and view only his or her scores. Pivot tables are a 
lot easier to grasp when you see them in action. Here's the one we're going to create in 
this section: 
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Look at Row 4. This shows that the student is Elisa. If we click Elisa's drop down arrow, 
we'll see this: 

 

Now we have another student to select (we'll only use two students, for this tutorial). We 
could untick Lisa, and tick Mary instead. Then her scores would display. 

The Subject and Month cells also have drop down lists. So we could view only January's 
scores, and just for Art and English, for example. 

So this is a Pivot Table - a report that we can manipulate by selecting items from drop 
down lists. Let's make a start. 

The first thing you need for a Pivot Table is some data to go in it. Instead of typing all the 
data out, you can simply grab ours. Go to this web page on our website and save the 
spreadsheet to your own hard drive: 

Once the spreadsheet is on your own computer, open it up. You should see this (If you 
get a warning across the top, click on Enable Editing): 

Highlight the data that will be going in to your Pivot Table (cells A1 to D37). On the Excel 
Ribbon, click the Insert tab. From the Insert tab, locate the Tables Panel. 
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On the Tables panel click Pivot Tables. The Create Pivot Tables dialogue box appears: 

 

In the dialogue box above, the data that we highlighted is in the Table/Range textbox. 
You can select different cells by clicking the icon to the right of the Table/Range textbox. 
You can also specify an external data source, such as a text file, for the data in your Pivot 
Table. 
We've selected a New Worksheet as the place where the Pivot Table will be placed. Click 
OK. 
When you click OK, Excel presents you with a rather complex layout. The area on the 
right should look something like one of these below, depending on which version of Excel 
you have: 
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It helps to have a look again at what we're trying to create. Here's the completed Pivot 
Table again: 
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Now take a look at the Pivot Table Field List image again, the one above the completed 
pivot table. It has tick boxes for Month, Subject, Student, and Score. These are column 
headings from the original spreadsheet data. We've put the Month in cell A7 on our Pivot 
Table, Subject is in cell B6, Student is in cell B4, and Score is the Average scores in cells 
C8 to G10. You'll see how it works, though. 
The idea is that you tick a box in the Pivot Table Field List, and then drag it to the four 
areas below. Excel will take care of the rest. 

So, tick all four boxes in the field list: 

 

 

Excel will create a basic (and messy) Pivot Table for you. But we're going to put our 4 
fields into the 4 areas below. Here are the 4 areas we can drag to: 
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For the Report Filter, we want the name of a Student. For the Column Labels, we want 
the Subject, and for the Row Labels, we'll just have the Month. The Values will be the 
Average scores. 
If you look at the Field areas after you have ticked all four boxes, however, you may see 
something like this: 
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Month, Subject and Student have all been grouped under Row Labels. You can drag and 
drop these, though. 
So, click on Student in the Row Labels box. Hold down your left mouse button, and then 
drag it in to the Report Filter box. If you don't fancy dragging and dropping, simply click 

the Student item with your left button. From the menu that appears, select Move to Report 
Filter: 

 

Your Field areas will then look like this: 
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Move Subject from Row Labels to the Column Labels area: 
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Your Field areas will then look like this: 

 

 

The Pivot Table on your spreadsheet will look a lot different, too. It should be looking like 
this: 
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Our Pivot Table is coming along, but the scores are all wrong, and it needs tidying up a 
bit. We'll continue this tutorial in the next part, below. 

 

11 Pivot Tables, Part Two 

The reason why the scores from our Pivot Table are so strange is because Excel is 
using the wrong formula. It's using a Sum total when we want it to use an Average. 

Here's the Pivot Table so far: 

 

The numbers have all been added up. But we want averages, instead. To change the 
formula, click on Sum of Score under the Values field area: 
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You'll see the following menu: 

 

Select, Field Settings (or Value Field Settings in Excel 2010 to 2016). You'll then see the 
following dialogue box: 
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Change the Formula from Sum to Average, and then click OK. Your Average formula 
won't be formatted to any decimal places. So, highlight you data. On the Home tab in 
Excel, locate the Number panel. Format your Averages so that it has no decimal places. 
Your Pivot Table will then look like this: 

 

Almost there! 

Look at cells A3, B3 and A4 above. These all have the not very descriptive names of 
Average of Score, Column Labels, and Row Labels. You can click inside of these cells 
and type your own headings, in the same way as you would to enter text in a normal cell. 

In the latest version of the Pivot Table below, we have renamed these cells. We've also 
centered the data. 
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Only one thing left to do - spruce up the table by adding a bit of color. 

Click anywhere on your Pivot Table to highlight it. Now look at the Ribbon at the top of 
Excel. You'll notice a Design menu. Click on this to see the various design options. 
The Pivot Table Style Options panel is interesting. 

 

Select Banded Rows and see what happens. Now click Banded Columns. 
Next to this panel, there are lots of Pivot Table Styles to choose from. Select one that 
catches your eye. Here's our finished Pivot Table again, only with a different Style: 

 

And here's the original: 
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There's a lot more you can do with Pivot Tables, but we hope that this introduction has 
whetted your appetite! But click the dropdown boxes on your Pivot table and play around 
with them. Change the values you see on the various lists for Student, Subject, and 
Month. 

In the next section, you'll learn how to reference other Excel worksheets. 

 

12 Reference other Worksheets 

You don't have to have all your data on one worksheet. In fact, it's common practise to 
create lots of worksheets in the same workbook. In this lesson, you'll see how to reference 
a formula that is on a different worksheet. This comes in handy if, for example, you have 
12 worksheets, one for each month of the year. You can then create another worksheet 
that holds things like totals for the entire year. We'll do that now. 

• Open up Excel (If it's already open, close the project you're currently working 
on and open a new blank workbook.) 

• Locate Sheet1, Sheet2, and Sheet3 at the bottom of Excel (Excel 2013 and 
2016 users will only have one worksheet. To create two more worksheets, 
click the plus symbol to the right of Sheet1.) 

• Rename these to May, June, July (Right click, and select Rename from the 
menu) 
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Click on the May sheet, and enter the same data as in the following image: 

 

Click on the June sheet and enter the following: 

 

Then click on the July sheet and enter the following: 

 

We now need to create a new worksheet. So click on the New Worksheet icon at the 
bottom of Excel, the one to the right of July in the image below (Excel 2013 and 2016 
users should click the plus symbol again): 

 

The new worksheet will be called Sheet4 by default. Rename it to Annual Total, and your 
workbook will look like this at the bottom (If your new worksheet is not at the end, hold 
down your left mouse button on the worksheets name. Keep it held down and drag to the 
end): 
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We're now going to add up the figures on the May, June and July worksheets, and put 
the answer on the Annual Total worksheet. 

Add a label to your Annual Total worksheet: 

 

Then click inside cell B1. 

To reference data on another worksheet, you use the exclamation mark (exclamation 
point, if you're in the USA). This is commonly called a Bang! 

So enter this in cell B1 of your Annual Total worksheet: 

=May!B1 
So we start with an equals sign (=), and then type the Name of the worksheet we want to 
reference (May). After the exclamation mark (bang), we have the cell we want to reference 
(B1). If you just type B1 by itself, Excel would assume that you meant the current 
worksheet. 

When you press the enter key, you should see this on your Annual Total worksheet: 
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This is the same figure as the one on your May worksheet. To add up all our monthly 
worksheets, just reference them in the same manner: 

=May!B1 + June!B1 + July!B1 
So, click inside cell B1 of your Annual Total worksheet and replace your formula with the 
one above. Press the enter key and you should see the answer: 

 

So, when you want to include figures or formula from other worksheets, remember to 
include the name of the worksheet followed by a bang 

 

13 The LOOKUP Function 

The LOOKUP function in Excel is used to search one column of data and find data in the 
corresponding row. For example, if you are searching a column of employee IDs the 
LOOKUP function can find, say, employee number 12345 in the ID column. Once it has 
found the ID 12345 it then can return data from that same row. Let's create a spreadsheet 
to clear things up. 

(The LOOKUP function we'll examine is called a VECTOR LOOKUP. There's also an 
ARRAY LOOKUP, but we won't cover that here.) 

Create the following simple spreadsheet: 
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So we have item numbers in the A column, then a list of products in the B column. Prices 
are in the C column. Our spreadsheet only has 10 items, but it could have hundreds, even 
thousands of entries. What we'd like to do is to take an item number and see what Shoe 
Type, or what Price corresponds to that item number. An item number of 229, for example, 
would return either "Stacked heel" or a price of 70. We can use the LOOKUP function for 
this. 

The LOOKUP function needs three between its round brackets. It needs these: 

LOOKUP(value_to_lookup, data_to_search, results_column) 
The value to lookup would be 229 in our example. This is in the A column. So the data to 
search is A2 to A10. If we want the results to come from the B column, we need the data 
from B2 to B10. If we wanted the Price to be returned, the data would be in C2 to C10. 

So we can add the following LOOKUP function to return a Shoe Type: 

=LOOKUP(229, A2:A10, B2:B10) 
Or this one, for the Price: 

=LOOKUP(229, A2:A10, C2:C10) 
So click into cell F1 in your spreadsheet. Click inside the formula bar and enter: 

=LOOKUP(229, A2:A10, B2:B10) 
When you've entered the formula, press Enter. You'll immediately see that there is a 
problem: 
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Cell F1 has #N/A in it, indicating there the value is not available. The reason for this error 
is that LOOKUP needs the data you're searching to be sorted, otherwise problems like 
this will occur. 

To sort the data, highlight the cells A2 to C10. With the cells highlighted, click 
the Editing panel on the Home ribbon. From the Editing panel, click Sort & Filter. Then 
select Smallest to Largest from the menu: 

 

 

When your data is sorted, LOOKUP should produce the correct result: 
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So, the Shoe Type for item number 229 is Stacked heel. 

There are some things to be aware of with the LOOKUP function. If the item you're 
searching for is less than the smallest item in your data then an error will occur. As an 
example, try entering 100 as the first number in your LOOKUP function: 

=LOOKUP(100, A2:A10, B2:B10) 
The N/A error should appear in cell F1 again. 

If LOOKUP can't find your value then it will return the highest value lower than your 
number. So, for us, the highest value lower than 229 is 156. 

As well as entering a number like 229 you can change it to a cell reference. So, the 
formula could be this: 

=LOOKUP(F1, A2:A10, B2:B10) 
In cell F1 you'd enter the value you want to search for. 

The value you're searching for doesn't have to be a number. You can enter text as well. 
For example, suppose we wanted to return the item number for Mules. We'd do it like this: 

=LOOKUP("Mules", B2:B10, A2:A10) 
The value to search for is now text, surrounded by double quotes. For us, the text is in 
the B column, B2 to B10. The Item Number is in the A column, A2 to A10. Excel will 
search for the text "Mules" in the B column and return the Item Number from the A column. 
(Instead of typing Mules in double quotes you can change it to a cell reference, if you 
prefer.) 

 

14 The VLOOKUP Function in Excel 

In the previous section, you learned about the LOOKUP function in Excel. There's another 
type of LOOKUP function you can use, however, called the VLOOKUP (there's also an 
HLOOKUP, but we won't cover that). VLOOKUP is used to search the first column of your 
spreadsheet for a value. If the value is found you can return data from any cell in that row. 
The VLOOKUP function needs three pieces of information, separated by commas. (You 
can also add an optional fourth value, which we'll see in a moment) 

LOOKUP(value_to_lookup, data_to_search, results_column, [match_case]) 
To illustrate VLOOKUP, create the following spreadsheet (or you can use the same one 
from the previous section). 
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Notice that the data in the first column, Item Number, is sorted lowest to highest. If you 
don't sort your data then LOOKUPS can give you problems. 

The item number we want to look up is in cell F1, and is a value of 583. We can use 
VLOOKUP to return the Shoe Type associated with item number 583. 

Click inside cell F2 to select it, then click inside the formula bar at the top. Enter the 
following formula: 

=VLOOKUP(F1, A2:C10, 2) 
Press the enter key on your keyboard when you have finished typing the formula. You 
should find the a value of "Kitten heel" is returned. 

So the value we want to search for is in F1. The data we want to search is the cells A2 to 
C10. The column that needs to be returned is column 2. When Excel finds the 583 it sees 
that this on row 6. The value in Row 6, column 2 is what VLOOKUP returns its answer. 

As was mentioned, you can add a fourth argument after the column number. This 
argument is either TRUE or FALSE and has to do with matching values from what you 
are searching for (the F1 for us). If you enter a value of TRUE (the default) then Excel 
looks for an exact match. If no exact match is found, it settles for the next lowest value. 
As an example, enter 580 in cell F1. When you press enter you should see "Platforms" 
appear in cell F2. Because we left off a value of TRUE or FALSE as the fourth argument 
it defaults to TRUE. When Excel can't find a value of 580 it looks at the next value lower 
than 580, which is 471 for us. This is on Row 5. Row 5, column 2 is "Platforms". 

Now click in cell F2 to highlight it. Click inside the formula bar and amend your function 
to this: 



  

IITCA ADVANCED EXCEL HANDBOOK 60 

 

=VLOOKUP(F1, A2:C10, 2, FALSE) 
All we've done is added FALSE on the end, but after a comma. Press the enter key on 
your keyboard and Excel gives you N/A error. It does this because FALSE means "find 
an exact match". Because we didn't have a value of 580 an error is returned. 

Change FALSE to TRUE and try again. You get Platforms as an answer. 

Now change the 580 in cell F1 to 150. When you press enter, cell F2 shows the N/A error 
again. This time, the error occurs because 150 is smaller than the smallest value we have 
for Item Number. 

Change the value in cell F1 to 612. Hit the enter key and you'll find that "Mules" appears 
in cell F2. 

Calculations with VLOOKUP 

You can use VLOOKUP to do some calculations for you. Suppose we wanted to work out 
the discount price for Mules. We can use VLOOKUP to get the price then multiply by its 
discount value in the D column. 

First, click into cell F3 to select it. Click into the formula bar and enter the following: 

=VLOOKUP(F1, A2:C10, 3, FALSE) 

When you press the enter key, you should find that a value of £40 appears in cell F3. The 
discount for the Shoe Type mules is 15%. We can use a second VLOOKUP to calculate 
how much the shoes would be if the 15% discount is applied. 

Click into cell F4. Click into the formula bar and enter the following: 

=VLOOKUP(F1, A2:D10, 3, FALSE) * (1 - VLOOKUP(F1, A2:D10, 4, FALSE) ) 
So we now have the VLOOKUP function twice. The first one gets the value in column 3. 
This is the Price of the shoes. The second one gets the value from column 4, which is the 
discount. The result from the first VLOOKUP (£40) is then multiplied by the result of the 
second VLOOKUP (15%). 

When you press enter on your keyboard a value of £34 should be returned - the price 
minus the discount. 

Using VLOOKUP for calculations can be quite tricky, but they are worth getting the hang 
of as mastering them will bring your Excel skills on a treat! 
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In the next section, you'll learn how to search a spreadsheet using two more powerful 
Excel Functions: MATCH and INDEX. 

 

15 Searching with MATCH and INDEX 

Suppose you have a really big spreadsheet with lots of information in the rows and 
columns. You have a long list of students in the first column, and lots of scores and grades 
associated with each student. The question is, how can you search for, say, just Ali's 
score in History. We'll do just that with the help of the Excel functions MATCH and INDEX. 

Create the following simple spreadsheet: 

 

We've gone for displaying just four students and their grades in five subjects: Math, 
English, Science, History, and Art. What we'd like to do is search for Ali's score in History. 
(Of course, with a simple spreadsheet like the one above, it's very easy to check for 
yourself by looking across the rows and down the columns. But your spreadsheet will 
probably be more complex than ours.) 

What we'll do is to use the Excel function MATCH to get a row number and then a column 
number. We'll then use these row and column numbers in the INDEX function. 

The MATCH function is used to return a row number or column number from an array of 
data. In our spreadsheet above, we have the students in the A column, on rows 2, 3, 4 
and 5. The student called Ali in on row 3. We can search the A column and return which 
row Ali is on. 

Click inside cell A7 in your spreadsheet and enter Student. In cell B7 enter the 
text Subject. In cell C7 enter Row, and in cell D7 enter Col. Your spreadsheet will then 
look like this: 
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Click inside cell A8 and enter Ali as the student. Click inside cell B8 and enter History as 
the subject: 

In cell C8, enter the following formula: 

=MATCH(A8, A2:A5, 0) 

MATCH needs three things: a value to search for, a range of cells to search, and a match 
type. The value we want to search for is Ali, which is cell A8 for us. If you like, you can 
type your search term between double quotes: 

=MATCH("Ali", A2:A5, 0) 

The A2:A5 above means search the cells A2 to A5. The match type we've used is zero. 
There are three match types you can use: 

1 Finds the largest value that is less than or equal to whatever it is 
you're searching for. So if your search term was 3 and you were 
searching the numbers 1, 2, 4, 5, 6 then MATCH would return a value 
of 2. If you use 1 as the match type, the numbers you are searching 
must be in ascending order. 
0 Use 0 to find an exact match (Finds the first match.) 
-1 Finds the smallest value that is less than or equal to whatever it is 
you're searching for. So if your search term was 3 and you were 
searching the numbers 6, 5, 4, 2, 1 then MATCH would return a value 
of 3. If you use -1 as the match type, the numbers you are searching 
must be in descending order. 

If you leave off the match type, you get a default of 1: 

=MATCH("Ali", A2:A5) 
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Match types can be very confusing, so you're better off just using 0, which is for an exact 
match. 

When you enter the MATCH formula above (the one with zero as the match type) then 
you'll get a value of 2 in cell C8: 

 

You might think that MATCH would return a value of 3. After all, the student called Ali 
starts on row 3. The reason MATCH return 2 is that Ali is the second student on the list 
we specified as the second parameter to MATCH, which was A2:A5. So John is at position 
1, Ali is at position 2, Priyanka is at position3, and Helen at position 4. 

Let's try and get the column number. 

Click inside cell D8. Now enter the following formula: 

=MATCH(B8, B1:F1, 0) 

You should get a value of 4 in cell D8: 
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This time, we've used B8 as the search term. This is where we typed History. We want to 
search the values from B1 to F1, which is where the subject headings are. The match 
type we've used is again 0, which is used for an exact match. A value of 4 is returned. 
(Math is at position1, English at position 2, Science is at position 3, History at position 4, 
and Art at position 5.) 

Now that we have a row and column number, we can use INDEX to look up a value. 

The Excel INDEX Function 

The INDEX function needs two things, a range of cells to search, and a row number. A 
third parameter, column, is optional. 

Click inside cell E8 on your spreadsheet. Now enter the following formula: 

=INDEX(B2:F5, C8, D8) 

When you press the enter key on your keyboard, your spreadsheet should look like this 
(we've added the text GRADE in cell E7 as a heading): 
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A value of B is now in cell E8. The cells B2 to F5 contains the data we want to search, 
which is all the grades. The cell C8 contains the row number we want use, and the cell 
D8 contains the column number. Excel uses the row and column numbers to return the 
value B. 

Although we have the cell references C8 and D8 in our INDEX formula, you can replace 
these with two MATCH functions, of you prefer. For example, enter the following formula 
in cell E9: 

=INDEX(B2:F5, MATCH(A8,A2:A5, 0), MATCH(B8, B1:F1, 0)) 

Instead of the cell reference C8 in the INDEX formula, we now have the MATCH formula 
we entered in to cell C8 previously. Likewise, the cell reference D8 has been replaced 
with its MATCH formula. The INDEX formula is now harder to read, though. 

If you want the INDEX formula to be even easier to read, you can replace cell references 
with named ranges. Here's how. 

Select the cells B2 to F5. Click inside the Name box at the top of Excel. Type the 
Name Grades: 
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Press the enter key on your keyboard to set up the named range for the data in cells B2 
to F5. 

Now click in cell C8 to select it. Again, click inside the name box. Type the 
name RowNumber and press enter: 

 

Click inside cell D8 and set up a name called ColNumber: 

 

You can now enter an INDEX formula that is more readable. In cell E10 enter the 
following: 

=INDEX(Grades, RowNumber, ColNumber) 

Press the enter key on your keyboard and your spreadsheet will look like this: 
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All three of the parameters for the INDEX function now have named ranges. 

Try typing a new student name in cell A8. Change Ali to Helen. You should find that 
grades will change to A. The row and column will both be 4: 

 

In the image below, we've changed the student to John and the Subject to English: 
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Using MATCH and INDEX can be a great way to search for values in your data, especially 
if your spreadsheet has lots of rows and columns. 

 

16 Create a Business Invoice, Part One 

In the last section, you saw how to use VLOOKUP. We're now going to create a business 
invoice that relies heavily on VLOOKUP. This is intermediate excel, so don't worry too 
much if you don't understand it all - just skip ahead to the next section and come back to 
it later. 
But the Invoice we're going to create looks like this: 

 

The invoice works by typing an invoice number into cell B5 (the 12343 in the image 
above). When you press the Enter key on your keyboard, data will be pulled from two 
more worksheets. The two worksheets contain Customer Data and Sales Data. The 
Customer's Name, Address, etc., gets pulled from a worksheet called Customer_Data, 
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and information about what the customer bought is pulled from a worksheet 
called Sales_Data. All the information on the Invoice worksheet is automatically updated 
when you change the invoice number is cell B5. 
Let's make a start, then. Create a new spreadsheet for this. If you're using Excel 2013 or 
Excel 2016, you'll only get one worksheet by default, so add two more at the bottom of 
Excel. Name the first worksheet Customer_Data, and the second one Sales_Data. The 
third worksheet should be changed to Invoice. Your new spreadsheet will then look like 
this at the bottom: 

 

Click on your Customer_Data worksheet to select it. On the first row, enter the following 
headings: 

CUSTOMER_NUMBER 
FIRST_NAME 

SURNAME 
ADDRESS1 
ADDRESS2 
ADDRESS3 
POSTCODE 

PHONE 
EMAIL 

You can format this first row, if you like. Make the text bold, and change the background 
color of the cells. Your Customer_Data worksheet will then look something like this: 
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Now enter some data under each heading. Enter data for the customers. Make up the 
details, just as we have below. The Customer number and the Phone number columns 
should be formatted as Text. You can leave the other Columns on General. Your 
worksheet will then look like this: 

 

Now click on your Sales_Data worksheet to select it. On the first row, enter the following 
headings (make sure you format the columns as below, as well): 

INVOICE_NUMBER General 
CUSTOMER_NUMBER Text 
DATE Date 
DESCRIPTION General 
QUANTITY General 
PRICE Currency 
TOTAL Currency 

Format the first row however you like. It should then look like this: 
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Notice that the first row also has a Customer_Number column. This will contain the 
same number from the Customer_Data worksheet. 
Now enter some data. You can use the same data as ours below, our just make up your 
own: 

 

The invoice number can be anything you like. But you need to get the Customer Number 
from your Customer_Data worksheet. The customer numbers we used are these: 

0001, 0002, 0003, 0004 

This means that customer number 0001, who is called Jack Attack, has the invoice 
number 12340; and customer number 0002, Mary Fae, has the invoice number 12341. In 
other words, the same customer numbers are on both the Customer_Data worksheet 
and the Sales_Data worksheet. 
Now that we have customer and sales data set up, we can turn our attentions to the actual 
invoice. We'll do that in the next part. Click the link below to move on. 

 

17 Excel Business Invoice, Part Two 
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In the previous lesson, you set up an Excel spreadsheet with three worksheets: 
Customer Data, Sales Data and Invoice. You have filled out the customer and sales 
data. It's now time to to set up the invoice. 
Click on your Invoice worksheet to select it. Create the following labels: 

 

The cell A11, under Date, should be formatted as a date. Description and Quantity can 
be left on General. Price and Total should be formatted as Currency. 
This is a very basic invoice, without any formatting. You can format it later, though, if you 
like. To start pulling data from the other two worksheets, we'll start with the Date, in cell 
A11. 

So click inside cell A11. Now enter the following VLOOKUP formula: 

=VLOOKUP(B5, Sales_Data!A2:Sales_Data!G5, 3) 
Just to refresh your memory, inside of the round brackets of the VLOOKUP function, we 
have three pieces of information: 

VLOOKUP(value_to_lookup, data_to_search, results_column) 
For us, the value we want to lookup is the invoice number in cell B5. The data to search 
can be found on the Sales_Data worksheet, in cells A2 to G5. (If you added more rows 
to your sales data then you need to change the G5 to whatever cell is the end of your 
data.) The column we want, the Date column, is column 3 (Column C). 
After you've entered the formula, press the enter key on your keyboard. You should 
see #N/A appear. The N/A stands for Not Available. The result is not available because 
you haven't entered an invoice number yet. Do that now. Look at 
your Sales_Data worksheet and locate one of your invoice numbers. Return to the 
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Invoice worksheet and enter your invoice number. Press the enter key on your keyboard 
and you should see a date appear in cell A11: 

 

The VLOOKUP for the other headings (Description, Quantity, Price, and Total) are very 
similar. The only thing you need to do here is to change the column number for the final 
position. So the VLOOKUP function cell B11 would be this: 

=VLOOKUP(B5, Sales_Data!A2:Sales_Data!G5, 4) 
And the VLOOKUP function cell C11 would be this: 

=VLOOKUP(B5, Sales_Data!A2:Sales_Data!G5, 5) 
Cell D11 is this: 

=VLOOKUP(B5, Sales_Data!A2:Sales_Data!G5, 6) 
And cell E11 is this: 

=VLOOKUP(B5, Sales_Data!A2:Sales_Data!G5, 7) 
Enter the VLOOKUP function for yourself in these cells. Your spreadsheet should now 
look like this: 
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Now change your invoice number in cell B5. When you press the enter key on your 
keyboard, you should find that your invoice will update all by itself: 

 

We now need to get the customer details for the invoice. This is more complicated. It's 
more complicated because we need to match a customer number from 
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the Sales_Data worksheet to a customer number from the Customer_Data worksheet. 
We'll see how to do it in the final part, below. 
 

18 Business Invoice, Part Three 

In the previous section, you pulled sales details about an invoice. In this section, you'll 
see how to get the customer details and add them to your invoice. 
The problem we face is that the customer data is on a separate worksheet to the sales 
data. The sales data worksheet is where we have the invoice number. The question then 
is how to associate an invoice number with the customer's details. The answer is 
the Customer Number. We have this on both the Customer_Data and 
the Sales_Data worksheets. We need to select a customer's details where the Customer 
Number matches on both worksheets. 
As an example, take the invoice number 12340 on the Sales_Data worksheet. In the next 
column, we have a Customer Number, which is customer 0001: 

 

This Customer Number is also on the Customer_Data worksheet: 

 

We can use nested VLOOKUPs to pull data from both worksheets where the customer 
number matches, and then insert just the customer details into the Invoice worksheet. 

Nested VLOOKUPs 

You can nest one VLOOKUP function inside of another. The technique can be quite tricky 
to understand, so you may need to re-read this a couple of times! 

Let's do the Phone number and email address first, as we'll use CONCATENATE as well 
as nested VLOOKUPs in the name and address fields, which will add another layer of 
complexity. 
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Click inside of cell D7 of your Invoice worksheet. Now click inside of the formula bar at 
the top of Excel and enter the following: (You can enter yours on one line. You can just 
copy and paste the formula below) 

=VLOOKUP(VLOOKUP(B5, Sales_Data!A2:Sales_Data!B5, 2), 
Customer_Data!A2:Customer_Data!I5, 8) 

Press the enter key on your keyboard and you should see a phone number appear in cell 
D7. This phone number is coming from the Customer_Data worksheet. But how does it 
work? 

First, have a look at what's needed for a single VLOOKUP again: 

VLOOKUP( value_to_lookup, data_to_search, results_column) 
The first item between the round brackets is value_to_lookup. Previously, we just entered 
a cell reference here. This cell reference was B5, which was the invoice number. This 
time, however, we don't need the invoice number from the Sales_Data worksheet. We 
need the Customer Number. This is in the cell next to the invoice number. Our inner 
VLOOKUP is designed to get this Customer Number. Here it is: 

VLOOKUP(B5, Sales_Data!A2:Sales_Data!B5, 2) 
Again, we used B5 as the value to look up. This is the invoice number. The data to search 
is in the cells A2 to B5 of the Sales_Data worksheet. The result column is column 2, which 
is the Customer Number. 

When this nested VLOOKUP has returned the Customer Number it is used with the outer 
VLOOKUP: 

=VLOOKUP(RETURNED_CUSTOMER_NUMBER, 
Customer_Data!A2:Customer_Data!I5, 8) 

The RETURNED_CUSTOMER_NUMBER above is the result from the inner VLOOKUP. 
This is then used to search the Customer_Data in cells A2 to I5 of the Customer_Data 
worksheet. The results column at the end is column 8, which contains the phone number. 

Now click inside of cell D8 of your Invoice worksheet. Enter this nested VLOOKUP: 

=VLOOKUP(VLOOKUP(B5, Sales_Data!A2:Sales_Data!B5, 2), 
Customer_Data!A2:Customer_Data!I5, 9) 

The only difference here is the column number at the end, column 9. This is where we 
have stored the email address on the Customer_Data worksheet. 

Press the enter key on your keyboard and you should see an email address appear in 
cell D8. 
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Now that we have an email address and phone number, we can get the customer's name 
and address. We could have separate cells here: a cell for the first name, a cell for the 
surname, a cell for the first line of the address, a cell for the next line of the address, and 
a separate cell for the zipcode/postcode. What we have done, however, is to have one 
cell for the customer's full name, and one cell for the customer's address. The customer's 
full name is in cell B7: 

 

And the customer's address is in cell B8: 

 

If you have a look at the customer name you'll see it's in the format LAST_NAME, 
FIRST_NAME, with a comma separating the two: 

Doe, Jane 
In order to get this we'll need two nested VLOOKUPs, one for the last name and one for 
the first name. In order to join the two together, and add a comma, we can use the inbuilt 
function CONCATENATE. The CONCATENATE function looks like this: 

CONCATENATE( TEXT_ITEM_1, TEXT_ ITEM_2, TEXT_ ITEM_3 …) 
You can have up to 255 Text items. A comma is used to separate each Text item. If you 
actually want a comma you need to treat it as a Text item. For example, here's our Doe, 
Jane text using CONCATENATE: 

=CONCATENATE("Doe", " ,", "Jane") 
So Text_1 is "Doe", Text_2 is "," and Text_3 is "Jane". 

With this in mind, here's our nested VLOOKUP with CONCATENATE (you can copy and 
paste this): 

=CONCATENATE(VLOOKUP(VLOOKUP(B5, 
Sales_Data!A2:Sales_Data!B5, 2), Customer_Data!A2:Customer_Data!C5, 
3)", ", VLOOKUP(VLOOKUP(B5, Sales_Data!A2:Sales_Data!B5, 2), 
Customer_Data!A2:Customer_Data!C5, 2)) 

This is a very long and messy formula. So let's break it down. 
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=CONCATENATE( 

VLOOKUP(VLOOKUP(B5, Sales_Data!A2:Sales_Data!B5, 2), 
Customer_Data!A2:Customer_Data!C5, 3), 

", ", 

VLOOKUP(VLOOKUP(B5, Sales_Data!A2:Sales_Data!B5, 2), 
Customer_Data!A2:Customer_Data!C5, 2) 

) 

The first VLOOKUP gets the surname from the Customer_Data worksheet. This goes as 
the first Text Item of CONCATENATE. To put the comma in we have ",". This is the 
second Text Item of CONCATENATE. The third Text item is the other VLOOKUP. This 
gets the first name from the Customer_Data worksheet. 

So click inside cell B7 on your Invoice worksheet. Click into the formula bar and enter (or 
copy and paste) the CONCATENATE code above. When you press the enter key on your 
keyboard you should have the surname and first name just like ours. 

The address uses the same technique, but the CONCATENATE formula is even longer. 
(It's only longer because we need the address lines and the zipcode/postcode. Here it is 
to copy and paste into cell B8 on your Invoice worksheet: 

=CONCATENATE(VLOOKUP(VLOOKUP(B5, 
Sales_Data!A2:Sales_Data!B5, 2), Customer_Data!A2:Customer_Data!I5, 
4), " , ", 
VLOOKUP(VLOOKUP(B5, Sales_Data!A2:Sales_Data!B5, 2), 
Customer_Data!A2:Customer_Data!I5, 5), " , ", 
VLOOKUP(VLOOKUP(B5, Sales_Data!A2:Sales_Data!B5, 2), 
Customer_Data!A2:Customer_Data!I5, 6), " , ", 
VLOOKUP(VLOOKUP(B5, Sales_Data!A2:Sales_Data!B5, 2), 
Customer_Data!A2:Customer_Data!I5, 7)) 

It looks insanely complicated, but it's just a longer version of the first CONCATENATE. 
The only difference is that we have more VLOOKUPs and more commas to insert. 

Once you've added the new formula, you should have an address in cell B8 of your 
worksheet. 
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And that's it! Try it out. Enter a new invoice number into cell B5, one of your invoice 
numbers from the Sales_Data worksheet. When you press enter, you should see the 
invoice automatically update itself. 

You can format your invoice however you like. Once formatted, the invoice can be printed 
out and sent to a customer. 

One final word on invoices. If you click File > New you should find that Excel comes with 
some invoices templates. Most of these templates use the VLOOKUP techniques you 
have explored in these lessons. Try them out and you should find that you have a better 
understanding of how the invoice templates work. 
 

Super Advanced Excel 

 

1 How to Create an Excel Template 

Creating a worksheet template can really save you a lot of time. Templates are especially 
useful if you find yourself having to create the same spreadsheet over and over. For 
example, if a spreadsheet has sheets for each month of year it becomes a bit if a chore 
if you have to type out the heading and formula for each sheet. Instead, you only need to 
do it once. Then you can save it as a template. If you need a new month, you can then 
Insert your template. Here's how. 

Open up a new workbook, with all three blank sheets at the bottom. Now delete two of 
the three sheets (If you have Excel 2013 or 2016 you don't need to do this as there's only 
one workbook by default): 

 

When you have deleted two sheets, the bottom left of your screen should look like this: 
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Now create the spreadsheet you want to use as a template. In the image below, we've 
just set up a simple spreadsheet with Week headings at the top and some labels down 
the left: 

 

Notice how none of the data is filled in for the weeks. The reason there are zeros for the 
Weekly Totals and the Item Totals is because we have the formulas in place but no data 
for the weeks. Once it is saved as a template and inserted into a new workbook, then the 
data can be added. We won't have to add the formulas because they are already in place. 

Once you have your spreadsheet looking the way you want it, click the Office button 
then Save in Excel 2007. In Excel 2010, click File > Save. In Excel 2013 and 2016, 
click File >Save, then under Save As, select Computer. Under the Computer heading, 
click the Browse icon. 
When the Save As dialogue box appears change the Save as type area at the bottom to 
Excel template. Type a name for your template: 
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Before clicking Save, notice the file name now ends in xltx, and that it is being saved to 
a Templates folder inside Excel (Custom Office Templates in later versions). 
Click the Save button to save your template. 

To use your template, close the current worksheet. Create a new blank workbook. Right 
click a sheet name at the bottom and select Insert from the menu that appears: 
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The Insert dialogue box should appear. Your template should be on the list, in 
the General section: 

 

Select your template, and click OK. Your template spreadsheet should then be inserted 
into your new workbook. You can delete any sheets you don't need, and rename the 
template. If you need a new sheet based on your template, right-click a sheet and select 
Insert from the menu again. 

Excel Templates Not Showing Up 

If you can't see your template, then you may need to reset your template location. To do 
this, you need to know your computer's user name. If you're not sure what this is, have a 
look at the start menu. On the right-hand side in Windows 7, you should see your user 
name right at the top: 



  

IITCA ADVANCED EXCEL HANDBOOK 83 

 

 

In Windows 10, type File Explorer into the Cortana text area, where it says, "Ask me 
anything". Open the File Explorer and have at look at the left-hand side. Click on Local 
Disk C. On the right-hand side, double-click on the Users folder and you should see your 
user name as one of the folder names. 
Once you have your user name, type it instead of YOUR_USER_NAME in the file location 
below: 

C:\Users\YOUR_USER_NAME\AppData\Roaming\Microsoft\Templates\ 
Now head over to Excel. Click File > Save. Then click the Options item from the menu 
on the left: 
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From the dialogue box that appears, select Save: 
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In the Default personnal templates location text area, paste the link above, not 
forgetting to paste your own user name in: 

 

Click OK on the dialogue boxes. You should now be OK to save and open up your new 
template file. 

In the next part, you'll see how to add a data form to an Excel spreadsheet. 

 

2 Data Forms in Excel 2007 to 2016 

If your spreadsheet is too big to manage, and you constantly have to scroll back and 
forward just to enter data, then a Data Form could make your life easier. To see what a 
Data Form is, we'll construct a simple spreadsheet. 

But a data form is just a way to quickly enter data into a cell. It is used when the 
spreadsheet is too big for the screen. To get a clearer idea of what a data form is, try this. 

• Enter January in Cell A1 of a new spreadsheet 
• From A1 to L1, AutoFill the rest of the months to December 
• Now, highlight the columns A1 to L1 (click on the letter A and drag to letter 

L) 
• On the Home tab in Excel, locate the Cells panel 
• On the Cells panel, click the Format item. (In Excel 2013 and 2016, you'll see 

a menu when you click Format. From the menu, select Column Width.) 
• From the Format menu, click Width 

 

• Enter a value of say 20 for the Column Width, and click OK 
• Some of your months should disappear from the spreadsheet 

The problem is, if you have to enter data under each month, you'd have to scroll across 
to complete the row. And then scroll back again to start a new row. Instead of doing this, 
we'll create a data form. You then enter data in the form to complete a row on your 
spreadsheet. No more scrolling back and forth! 
In the version of Excel 2007 we have, Data Forms have been hidden. They used to be 
sitting on the Data menu. Now they are not. In fact, quite a few menu options have 
disappeared in Excel 2007 and Excel 2010. 
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To find Data Forms, click on the Office button in the top left of Excel, for 2007 users. From 
the Office button menu, click on Excel Options: 

 

For Excel 2010 to 2016 users, click the File tab in the top left. From the menu on the 
left, click Options: 
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When you click the Excel Options button, you'll see this dialogue box popping up: 

 

Click the Customization item on the left in Excel 2007. In Excel 2010 to 2013 there is 
a Quick Access Toolbar item. Click that instead of Customization: 
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The idea is that you can place any items you like on the Quick Access toolbar at the top 
of Excel. You pick one from the list, and then click the Add button in the middle. 

To add the Data Form option to the Quick Access Toolbar, click the drop-down list where 
it says Choose Commands From. You should see this (we've chopped a few options 
off, in the image below): 
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Click on Commands Not in the Ribbon. The list box will change: 

 

From the Commands Not in the Ribbon list, select Form. Now click the Add button in the 
Middle. The list box on the right will then look something like this one: 
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Explore the other items you can add to the Quick Access Toolbar. You might find your 
favorite in there somewhere! 

When you click OK on the Excel Options dialogue box, you'll be returned to Excel. Look 
at the Quick Access toolbar, and you should see your new item: 

 

 

Back to the spreadsheet. Type any number you like in cell A2, under January. Then type 
a number in cell B2 for February. Now highlight the columns A to L again. This is so that 
Excel will know which is a column heading and which is the data. 

Click the Form item you have just added to the Quick Access toolbar: 

You should then see this: 
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All the Columns in the spreadsheet are now showing. Enter numbers for the other months. 
To start a new row in your spreadsheet, you just click the New button on the right. 
In the next part, you'll see how to add drop down lists to an Excel spreadsheet. 

 

3 Drop Down Lists in Excel 

If you have to type the same data into cells all the time, then adding a drop down list to 
your spreadsheet could be the answer. In Excel, this comes under the heading of Data 
Validation. 

In the example below, we have a class of students on a drop down list. We only have to 
click a cell in the A column to see this same list of students. You'll see how to do that now. 
Here's a picture of your finished spreadsheet: 

 

In the image above, we can simply select a student from the drop down list - no more 
typing! We can also do the same for the Subject and Grade. 

So, create the following headings in a new spreadsheet: 

Cell A1 Student 
Cell B1 Subject 
Cell C1 Grade 
Cell E1 Comments 

We now need some data to go in our lists. So, type the same data as in the image below. 
It doesn't need to go in the same columns as ours. But don't type anything in columns A, 
B, C or E: 
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The data in Columns F, G and H above will be going in to our list. 

Now click on Column A to highlight that entire column: 

 

With Column A highlighted, click on Data from the Excel Ribbon at the top. From the Data 
tab, locate the Data Tools panel. On the Data Tools panel, click on the Data 
Validation item. Select Data Validation from the menu: 
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When you click Data Validation, you'll see the following dialogue box appear: 

 

To create a drop down list, click the down arrow just to the right of "Allow: Any Value" on 
the Settings tab: 

 

Select List from the drop down menu, and you'll see a new area appear: 
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Source means which data you want to go in your list. You can either just type in your cell 
references here, or let Excel do it for you. 
To let Excel handle the job, click the icon to the right of the Source textbox: 

 

When you click this icon, the Data Validation dialogue box will shrink: 

 

Now select the cells on your spreadsheet that you want in your list. For us, this is the 
Students: 

 

Once you have selected your data, click the same icon on the Data Validation dialogue 
box. You'll then be returned to the full size one, with your cell references filled in for you: 
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Click OK, and you'll see the A column with a drop down list in cell A1: 

 

However, you don't want a drop down list for your A1 column heading. To get rid of it, 
click inside of cell A1. Click the Data Validation item on the Data Tools panel again to 
bring up the dialogue box. From the Allow list, select Any Value: 

 

Click OK on the Data Validation dialogue box, and your drop down list in cell A1 will be 
gone. 

The rest of the column will still have drop down lists, though. Try it out. Click inside cell 
A2, and you'll see a down-pointing arrow: 
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Click the arrow to see your list: 

 

Select an item on your list to enter that name in the cell. Click any other cell in the A 
column and you'll see the same list. 

Adding a drop down list to your cell can save you a lot of time. And it means that typing 
errors won't creep in to your work. 

Exercise 
Add drop down list to the B and C columns. The B column should contain lists of Subjects, 
and the C column a list of Grades. Make sure that the cells B1 and C1 don't contain drop 
down lists. When you're finished, the Subject column should look like this: 
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And the Grade column should look like this: 

 

In the next part, you'll learn how to add a Spin Button control to an Excel cell. 

 

4 Add your own Error Messages 

In the previous part, you saw how to add drop down lists to your Excel spreadsheets. In 
this part, we'll display an error message for our users. If you haven't already done so, you 
need to do the previous tutorial first. 

Data Validation - restricting what data can go in a cell 

You can also restrict what goes in to a cell on your spreadsheet, and display an error 
message for your users. We'll do this with our Comments column. If users enter too much 
text, we'll let them know by displaying a suitable error box. Try the following: 

• Highlight the E column on your spreadsheet (the Comments column) 
• From the Data Tools panel, click Data Validation to bring up the dialogue box again 
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• From the Allow list, select Text length: 

 

When you select Text Length from the list, you'll see three new areas appear: 

 

What we're trying to do is to restrict the amount of text a user can input into any one cell 
on the Comments column. We'll restrict the text to between 0 and 25 characters. 

The first of the new areas (Data) is exactly what we want - Between. For the minimum 
textbox, just type a 0 (zero) in there. For the maximum box, type 25. Your dialogue box 
should then look like this: 

 

To add an error message, click the Error Alert tab at the top of the Data Validation 
dialogue box: 
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Make sure there is a tick in the box for "Show error alert after invalid data is entered". 

You have three different Styles to choose from for your error message. Click the drop 
down list to see them: 

 

In the Title textbox, type some text for the title of your error message. 

 

Now click inside the error message field and type some text for the main body of your 
error message. This will tell the user what he or she did wrong: 
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Click OK on the Data Validation dialogue box when you're done. 

To test out your new error message, click inside any cell in your Comments Column. Type 
a message longer than 25 characters. Press the enter key on your keyboard and you 
should see your error message appear: 

 

As you can see, the user is prompted to Retry or Cancel. But our title (Too many 
characters) is at the top, our Stop symbol is to the left, and our Error message is displaying 
nicely! 

Hiding Spreadsheet Data in Excel 2007 to 2016 

The data that went in to our lists doesn't need to be on show for all to see. You can hide 
this text quite easily. 

• Highlight the columns with your data in it (F, G and H for us) 
• Click on the Home tab from the top of Excel 
• Locate the Cells panel 
• On the Cells panel, click on Format. You'll see the following menu: 
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Move your mouse down to Hide & Unhide and you'll see a Sub Menu appear: 

 

Click on Hide Columns from the Sub menu. Excel will hide the columns you selected: 
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In the spreadsheet above, the columns F to H are no longer visible. 

To get them back again, highlight the columns E and I. From the same sub menu, 
click Unhide Columns. 
In the next part, you'll learn about Array Formulas. 

 

5 Array Formulas  

An array formula, as its name suggests, is a formula that you use on arrays. Which begs 
the question, what is an array? 

What is an Array? 

An array is a collection of values, rather than a single value. If you had some exam scores 
in the A column, then all those scores collectively would be called an array of exam 
scores. Likewise, if you had a column full of car names, then all of those car names 
together would be an array of car names. So, an array is a lot of values treated as one 
group. 

What is an Array Formula? 

An array formula is just a formula that works with arrays (groups of values). As an 
example, take the Chocolate Addiction spreadsheet you constructed in a previous 
section. It was like this: 
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So we want to multiply the cost of each chocolate bar by how many we've eaten. The 
formula to go in the D column in the image above is simple: 

=PRICE * NUMBER OF BARS EATEN 

The first one (0.35 * 17) gives an answer of 5.95. In cell D3, we could have entered: 

= B3 * C3 

To get the rest of the Cost column, you could then use AutoFill. This is what you did 
previously. 

However, you can use an Array Formula instead of using Autofill. Try this: 

• Create the same spreadsheet as in the image above 
• Now highlight the cells D3 to D6: 

 

• Click inside the formula bar at the top. Type the following formula: (DON'T press 
the enter key yet.) 

= B3:B6 * C3:C6 
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• With the formula in the formula bar, hold down the SHIFT and CTRL keys on your 
keyboard. Keep them held down, and then press the enter key. The answers to 
all four of the Costs should appear in the empty cells: 

 

Notice the formula bar now: the formula you entered is now surrounded by curly brackets: 

{= B3:B6 * C3:C6} 

And that's how you can tell that the cell contains an array formula - it's surrounded by 
curly brackets. Note that you can't enter the curly brackets yourself. So you couldn't type 
the formula then type the curly brackets on the left and right. You have to press SHIFT + 
CTRL then press the enter key to get an array formula. 

So how does it work? Well, we used two arrays: one array that grouped all the Prices, 
and another array that grouped all the Number of bars eaten. The Prices array was in the 
cells B3 to B6, while the Number array was in cells C3 to C6. We told Excel to use these 
two arrays in a formula. Specifically, we told Excel to multiply the two arrays together and 
place the answers in the cells D3 to D6 (the cells we highlighted). 

Let's try another example of an array formula. This time, we'll enter an array formula in 
only one cell. 
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Highlight the cells D3 to D6. Now press the delete key on your keyboard to get rid of all 
those array formulas. 

Click inside cell D3 and enter the following formula: 

= B3 * C3 

Your spreadsheet should now look like this: 

 

Now use AutoFill to get the answers in cells D4, D5, and D6. 

OK, this is the standard way you've been doing things. To get the total, you could click 
into cell D7 and use the following SUM function: 

=SUM(D3:D6) 

This would then get you an answer of 26.18 in cell D7. Add some text as a label in cell 
C7, so that your spreadsheet looks something like this: 
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Now let's use an array formula instead. 

Add some text as a label to cell C8: Cost using Array Formula. Now click inside cell D8. 
Enter the following formula, but don't press the enter key just yet: 

=SUM(B3:B6 * C3:C6) 

Hold down the SHIFT and CTRL keys. Keep them held down and press the enter key on 
your keyboard. You should see the same answer, 26.18, appear in cell D8. The formula 
bar at the top will show the curly brackets surrounding the formula: 

 

Notice that the array formula you created doesn't need to use the figures in the D column 
at all. In fact, if you deleted the numbers in cells D3 to D6 only the Cost using 
Autofill figure would disappear from cell D7. The Cost using Array Formula would still 
be there in cell D8. That's because you used two arrays to get the total, the array in cells 
B3 to B6 and the array in cells C3 to C6. 
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So, if you want to save yourself some typing and Autofilling then think about using an 
array formula instead, especially if you have groups of numbers to work with. 

In the next lesson, you'll see how to use an array formula with something called 
Frequency Distribution. 

 

6 Frequency Distribution  

Frequency distribution is displaying how often something falls into a certain category. For 
example, suppose you had a range of age groups (categories). Like this: 

25 and under 
26 to 35 
36 to 45 
46 to 55 
56 and over 

Your company is bringing out a new drink. What you want to know is which age groups 
liked your new drink the most. You could then target your advertising at the age groups 
that like your new drink. After all, you don't want to waste your advertising dollars on age 
groups that hated your drink. Let's see how to use Frequency Distribution to display the 
information collected from a survey. 

The first thing you need is some data. Download the following Excel spreadsheet: 

Save it to your computer, and then open it up. The data is all in the A column, and is a list 
of people who liked the drink, by age. The first thing you need to do for Frequency 
Distribution is to lay out your groups (called Bins in Excel). 

• Click inside cell C1 and type the word BINS 
• Click inside cell D1 and type the word FREQUENCY: 
• Your spreadsheet should then look like this: 
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• Enter the following numbers in the BINS column: 25, 35, 45, 55, 65: 

 

When you are entering your bins, you only need one number. So you don't need to type 
"under 25", or "26 to 35", etc. Excel take the first single number to mean 0 to 25. For the 
35, Excel takes it to mean "add 1 to the previous bin (25) then go up to 35. For the 45, 
Excel then goes from 36 to 45, and so on. (Our bins all go up in groups of 10. But you 
don't have to go up in stages of 10. You can pick any number you like for your stages.) 
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We now need to work out how many people liked the drink and were under 25, how many 
liked it and were aged 26 to 35, etc. There's an Excel function that can do all the 
calculations for us. That function is called FREQUENCY. The FREQUENCY function 
takes a list of data (an array) and an array of bins, and puts all the numbers in the correct 
categories. 

To see how it works, highlight the cells D2 to D6. 

D2 to D6 is where Excel will keep track of how many people belong in each group. 

Now click inside of the formula bar and type the following formula (DON'T press the enter 
key on your keyboard just yet): 

=FREQUENCY(A2:A81, C2:C6) 

 

The FREQUENCY function needs two arrays. The first array is your data, which for us is 
in the A column, in cells A2 to A81. The second array that the FREQUENCY function 
needs is your bins. Our bins are in the cells C2 to C6. A comma separates the two arrays. 

Once you have typed the formula, hold down the SHIFT and CTRL keys. Keep them held 
down and then press the enter key on your keyboard. This will create an array formula. 
Your spreadsheet will then look like this: 
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So our FREQUENCY array formula has worked out that 34 people aged 25 or under liked 
the drink. In the age group 26 to 35, 18 people liked it. Of those who are aged 36 to 45, 
12 people liked the drink. 6 people aged 46 to 55 liked it, and 8 people over 65 like the 
drink. Clearly, you'd want to target your advertising at those who are 35 and under. 

You can create a chart out of all this information. 

Highlight the cells C1 to D6: 

 

From the Insert ribbon at the top of Excel, select a 2-D Column Chart: 
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The chart will then look like this on your spreadsheet: 

 

However, this is not quite what we're looking for. Excel has taken the numbers in the Bins 
column and the numbers in the Frequency column and created two sets of bars in the 
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chart. We only want single bars. We want the Bins at the bottom (Horizontal Axis) and 
Frequency on the left side (Vertical Axis). 

To remedy the situation, right-click on the chart. From the menu that appears, 
choose Select Data: 

 

When you click on Select Data, you should see a dialogue box appear. This one: 
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Click the Edit button, under Horizontal (Category) Axis Labels. You'll then see this box 
appear: 

 

Go back to your spreadsheet and select the cells C2 to C6: 

 

Now click OK on the Axis Labels dialogue box. The Select Data Source dialogue box 
will then look like this: 

 

On the left-hand side, under Legend Entries (Series), highlight the BINS entry. Then 
click the Remove button: 
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This should leave you with just the Frequency entry. Click OK, and your chart should now 
look like this: 

 

You can change the titles at the top and bottom so that it looks like ours: 
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To change the Frequency title at the top, double click the text and type something else. 
To change the Frequency series title at the bottom, click inside of cell D1 on your 
spreadsheet. Type Age Groups instead of Frequency. 

And that's it for Frequency Distribution. If you have a lot of data that can be grouped into 
categories, then a Frequency Distribution count, along with a chart, can make all the 
difference. In the next lesson below, you'll learn about Web Integeration 

 

7 Excel and Web Integration 

A Web Query is when you send a request to a web page and ask for some data to be 
returned. You'll see how to do that in this section, by importing data into your spreadsheet 
from a web page on our web site. 

There are many reasons why you would want to do that. If, for example, you're a hard-
working sales person out in the field, and a customer wants the latest prices, you could 
run a web query in Excel and pull the prices from your employer's website. 

How to run a Web Query in Excel 2007 to 2016 

You'll now learn how to use Web Queries in Excel. For this lesson, you'll need an active 
internet connection. We're going to connect to a web page, and download a product list 
straight into a spreadsheet. Off we go! 

• Open Excel 
• Connect to the internet, if you're not already online 
• Click inside A1 on your new worksheet 
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• From the Excel Ribbon, click on Data 
• From the Data tab, locate the Get External Data panel: 

 

 

From the Get External Data panel, click on From Web. You'll then see the following 
dialogue box appear: 

 

The web page that appears in the middle is usually the Homepage from Internet Explorer 
- Google, in the image above. 

The idea is that you type the address of a web page and then click Go. Excel will then 
fetch the data for you. 
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So, in the Address box, where it says about:blank in the image, type the following address: 

http://www.homeandlearn.co.uk/ME/webquery1.htm 
Before you click Go, click the Options button in the top right of the New Web Query 
dialogue box. You'll see this dialogue box appear: 

 

For this first web query, we're not going to change any of these settings. But the 
Formatting section is the one you'll use most. You can import the web page with all its 
current formatting, use just Rich Text formatting, or have no formatting at all. (Rich Text 
formatting will get you things like bold text, but won't give you any of the fancy stuff on the 
page.) 

Click OK on the Options dialogue box to return to the New Web Query. Now click the Go 
button. 

When you click the Go button, Excel will try to connect to the address you gave it. If it 
can't get through, you'll see a "Page Cannot be Found" error page: 

If that's what you're getting, make sure you are connected to the internet. Check if you've 
typed the address correctly. Make sure that your firewall is not blocking Excel. 

If Excel is successful, you'll see the data appear in the Web Query window: 
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Note the arrows in the yellow squares. You can select the tables you want to import. Click 
the first yellow box, and it will turn green and have a tick in it. Like this one: 

 

Once you have the data selected, click the Import button at the bottom of the New Web 
Query window. You'll get yet another dialogue box: 
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There's not much to do, here. But if you want to import the data to a different starting cell, 
or even a new worksheet, select the appropriate option. For this particular import, Excel 
is only giving us the option to view the data as a Table. Click OK and the import will begin. 
You should see this in cell A1 on your spreadsheet: 

 

If the import is successful, your spreadsheet should look like ours below: 

 

As you can see, the data from our web page has been imported into Excel! Let's try 
another one. 

Web Query Two 
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The next web query we'll do will see an import of full HTML formatting. When you're 
finished, you'll see why this can be a problem. 

• At the bottom of Excel, click on Sheet2, or add a new worksheet 
• On the fresh worksheet, click inside cell A1 
• Click on the Data menu, then on click From Web on the Get External Data panel 
• In the New Web Query Address box, type the following Address (don't click the Go 

button just yet): 

http://www.homeandlearn.co.uk/ME/webquery2.htm 
Click the Options button in the top right of the dialogue box: 

 

This time, select Full HTML Formatting, as in the image above. Click OK, then click the 
Go button. 

Excel will bring back your data. Click the yellow box with the arrow in it to select all the 
data: 
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Click the Import button at the bottom when your dialogue box looks like the one above. 
When you see the Import Data dialogue box, just click OK. The data will then be 
imported into Excel: 

 

The problem with importing full HTML is that some of that fancy formatting you did won't 
convert very well in Excel. In the image above, our Latest Prices heading has been 
mangled! 
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In other words, you may have to spend time re-formatting your spreadsheet. 

To get the full heading back, for example, highlight the first row, from A1 to G1. Click on 
the Home menu, and then locate the Alignment panel. Click Merge and Centre. 

But that's it for Web Queries. They are quite simple to do, and can come in handy if you're 
out on the road. In the next part, we'll take a look at Hyperlinks in Excel. 

 

8 Hyperlinks in Excel 

You can place Hyperlinks in the cells on your spreadsheet. To quickly go to a different 
worksheet or workbook, you would simply click the link. We'll see how to do that now. 

• Click inside of cell A1 of a new spreadsheet. (If you're using Excel 2013 and 
2016, you only get one worksheet. Add two more by clicking the plus 
button just to the right of Sheet1 at the bottom of Excel.) 

• From the Excel Ribbon, click the Insert tab 
• From the Insert tab, locate the Links panel 
• Click on Hyperlink: 

 

When you click the Hyperlink item, you'll see the following dialogue box appear: 
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We're going to create a link to another worksheet in this same spreadsheet. So, 
under Link to on the left, click on "Place in This Document". 
 
When you click Place in This Document, the dialogue box changes to this: 

 

We'll try linking to Sheet3 on our spreadsheet. When the link is clicked on Sheet1, we 
want to jump to a specific cell on Sheet3. 

• Under "Or select a place in this document", click on Sheet3 
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• Type some text in the Text to display box at the top. This is the text of your 
hyperlink, as it will display in the cell 

• Click the Screen Tip button at the top, and type some text for when the 
mouse is over the link 

Your dialogue box will then look something like this one: 

 

Click OK when you're done, and you'll see cell A1 on your spreadsheet change: 

 

Hold your mouse over the link and you should see your Screen Tip: 
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Try to click on your link, and you might find that nothing happens! To use the hyperlink, 
you have to click the link and hold your mouse down for a second or so. Let go of the left 
mouse button and you should jump to Sheet 3. 

If you want to open an existing spreadsheet, instead of jumping to a location in the current 
one, click the Hyperlink item on the Links panel to bring up the dialogue box again. 

 

• Under Link to on the left, select Existing File or Web Page 
• Navigate to the location of your spreadsheet from the Look in area 
• Select the spreadsheet to open 
• Type some text, and a Screen tip 
• Then click OK 

When you click your new link, the spreadsheet file you selected will open. 

But we'll leave this brief introduction to the subject of Web Integration in Excel. There's a 
whole lot more you can do in this area: Upload your spreadsheet data to the web, instead 
of downloading like we did; save your spreadsheet as a web page; create a spreadsheet 
that others can interact with, email your spreadsheets, and a whole lot more besides. In 
fact, a whole book could be written on the subject! 

In the next part, we'll take a look at Object Linking and Embedding in Excel. 

 

9 Object Linking and Embedding 



  

IITCA ADVANCED EXCEL HANDBOOK 126 

 

Object Linking and Embedding (or OLE for short) is a technique used to insert data from 
one program into another. We'll create a simple spreadsheet to illustrate the process, and 
place it in to Word document. When the Excel spreadsheet is updated, you'll see the 
Word version update itself as well. 

If you don't want the data to update in Word, for example, it's called Embedding; if you do 
want the data to update, it's called Linking. We're going to do Linking. For this exercise, 
you need Word 2007 to Word 2013 as well as Excel 2007 to 2013. 

First, create the simple spreadsheet below, and enter the formula shown in cell E3: 

 

When you enter a number in cell E1, the answer is placed in cell E3 (don't do this yet). 

With your spreadsheet created, highlight the cells A1 to E3. Click on the Home tab in 

Excel. On the Clipboard panel, click on Copy. 
Now switch to Word. On the Home tab in Word, locate the Clipboard panel, and 
the Paste item: 

 

 

Click on Paste. From the Paste menu, select Paste Special: 
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When you click on Paste Special, you'll see the following dialogue box appear: 

 

Select Microsoft Office Excel Worksheet Object from the dialogue box. On the left hand 
side, select Paste Link. Click OK. 
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When you click OK, Word will insert the spreadsheet from Excel: 

 

It's even retained the cell formatting! 

To check that it really does update in Word, switch back to Excel. Click inside Cell E1 and 
enter the number 7 (If your cells are still highlighted, just press the enter key on your 
keyboard). Press Enter, and you should have the same answer as in the image below: 

 

Now switch back to Word, and you should see that it too has the same answer: 
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Word has successfully linked the data from Excel! If you don't want the updates, you 
would choose Paste from the Paste Special dialogue box instead of Paste Link. 
 
You can link or embed things like Charts or Pivot Tables into Word, though, and it can 
come in really useful. 

In the next part, you'll see how to spruce up an Excel spreadsheet with drawing objects. 

 

10 Insert Drawing Objects 

A drawing can liven up a dull spreadsheet. Some good line art, or even simple shapes, 
can help illustrate your data. In this lesson, you'll see how to add simple shapes, and 
textboxes to your spreadsheet. 

First, look at the spreadsheet below. Unless you know about Cosines, Adjacent angles, 
and Hypotenuse, the data below will be a bit bewildering: 

 

However, add a few shapes, along with some colour, and it becomes clearer what the 
data is for (the Cosine in the image below has been formatted to 2 decimal places): 
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We'll now show you how to produce a spreadsheet like the one above. Don't worry if you 
haven't a clue about Cosines - it's not important for this lesson. (We'll show you the 
formula, though.) 

How to Draw a Shape on an Excel Spreadsheet 

To insert a shape on your spreadsheet, do the following. 

• From the Excel Ribbon, click on Insert 
• Locate the Shapes panel: 

 

For Excel 2013 and 2016 users, locate the Illustrations panel instead. The Shapes item 
is on there: 
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On the Shapes panel, click the drop down arrow to see all the available shapes: 

 

• Under Basic Shapes, select the Right Triangle 
• Hold down your left mouse button on your spreadsheet, and drag to create your 

shape. Let go when you have a decent sized triangle. You'll see something like 
this: 
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The green circle (white in Excel 2013) allows you to rotate the shape. The other circles 
(and squares) are sizing handles. Hold your mouse down over one of these and drag to 
resize your shape, if it's not the size you want it. 

But we'd like the triangle pointing the other way. So hold your mouse down on the green 
circle, and drag to rotate your triangle: 

 

You should see an outline, like the one above. Let go of your left mouse button when it is 
in position: 
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As you can see, the green circle is now on the left hand side. 

If you look on the Excel Ribbon at the top, you'll notice that it has changed - a Format tab 
has appeared. You'll see all the various options for shapes. Locate Shape Fill on 
the Shape Styles panel, and click to see the Fill options: 

 

Select a colour for your triangle. You'll also want to select a Shape Outline, underneath 
Shape Fill. Select the same colour as your Fill, and your triangle will look something like 
this one: 
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Add a Text Box to an Excel Spreadsheet 

To get the letter B in the triangle, we'll add a text box. So, on the Insert Shapes panel 
again, you'll notice a Text Box option. Click on this to select it: 

 

Excel 2013 users have a separate Text panel, on the left hand side. Click the Text Box 
item: 

 

Now move back to your spreadsheet, hold down your left mouse button, and drag out a 
Text Box. Let go of the left mouse button and you'll have something like this: 

 

With the cursor inside of the Text Box, simply type the letter B. Because it's text, you can 
highlight your letter and format it. In the image below, we've increased the font size: 
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We now need to drag our Text Box onto the shape. Move your mouse over the Text Box 
until the cursor changes shape to four arrowheads (this can be tricky): 

 

Once your cursor changes shape, hold down the left mouse button and drag your Text 
Box on to the triangle: 

 

With the Text Box selected, use the arrow keys on your keyboard to nudge it in to position. 
Fill the Text Box in the same way as you did for the triangle. To get rid of the text box 
border, click Shape Outline just below Shape Fill. Set it to No Outline. It will then look 
like this: 
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If you need to move your triangle and Text Box, you can select them both at the same 
time, and drag them as one. Click on your Triangle to select it. Now hold down the CTRL 
key on your keyboard. With the CTRL key held down, click on your Text Box. Both will 
now be selected: 

 

With both the triangle and the Text Box selected, hold your mouse over the selected 
shapes. When your cursor changes to the four arrowheads, hold down the left button and 
drag your shapes to a new position: 

 

You can finish off the formatting in the normal way. In the image below, we selected all 
the cells surrounding the shape, and added a background colour from 
the Home menu, Font panel. 
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If you look again at the finished version, you'll see the rest of the colours we chose. These 
are just filled cells from the Home > Font panel: 

 

The text in the cells is just entered in the normal way. The formula for the Cosine in cell 
G22 of our spreadsheet has this syntax: 

=DEGREES(COS(Adjacent_Cell_Reference / Hypotenuse_ Cell_Reference)) 
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An example of how to use is it this: 

=DEGREES(COS(F18 / F10)) 
When the user types in a value for the Hypotenuse or the Adjacent, the Cosine number 
will change. 

But you can add any shapes you want to liven up your spreadsheet. It doesn't have to 
look plain, white and dull! 

 


